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UVOD
Logisim je obrazovni alat za kreiranje i simulaciju digitalnih logičkih sklopova.

Sa svojim jednostavnim sučeljem alatne trake omogućuje lakše izgraditi simulaciju
sklopova, odnosno jednostavnije olakšati učenje većine osnovnih pojmova vezanih
uz digitalnu logiku, logičke sklopove i procesorske sustave. Uz mogućnost izgrade
većih i složenijih sklopova pomoću  podsklopova i spajanja sklopova s vodičem
jednim potezom miša Logisim može se koristiti za dizajn i simulaciju cijelog CPU-a za
obrazovne svrhe.

Logisim koriste studenti na fakultetima i sveučilištima širom svijeta u različitim
oblicima nastave, u rasponu od kratkih nastavnih jedinica izučavanja digitalne logike,
u računalnim anketama i provjerama znanja, na računalima organizacijskih tečajeva i
na semestrima tečajeva o arhitekturi računala.



Milan Korać: Logisim

Tehnička škola Ruđera Boškovića 5

Značajke:

 Besplatan (Logisim je besplatna verzija (GPL) – Open Source).

 Radi na bilo kojem računalu koje podržava Javu 1.4 ili noviju; posebna
verzija je izdana za MacOS i Windows. Multi – platforma je važna za
korisnike koji imaju različite računalne sustave jer omogućuje
kompatibilnost.

 Sučelje za crtanje je bazirano intuitivno alatnoj traci. Kodirana boja
vodiča pruža pomoć u simulaciji  digitalnih sklopova i otkrivanju
pogrešaka u digitalnim sklopovima.

 Alat za crtanje linija crta vodoravne i okomite linije te automatski spaja
komponente i vodiče što omogućuje lako crtanje digitalnih logičkih
krugova.

 Završeni sklopovi mogu biti spremljeni u datoteku ili eksportani u GIF
datoteku ili se ispisuju na papir.

 Izgled digitalnih krugova može se koristiti kao podsklopovi (podkrugovi)
drugih većih digitalnih krugova što omogućuje hijerarhijsko projektiranje
sklopova.

 Komponente digitalnog kruga sadržavaju ulaze i izlaze, logičke
sklopove, multipleksore, aritmetičke krugove, RAM i ROM memoriju i
komponente kompatibilnosti

 Sadrži analizu digitalnih krugova koje omogućuju pretvorbu između
krugova, tablicu stanja digitalnog kruga i njegovu minimizaciju.
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1 IZGLED RADNOG SUČELJA

Kod pokretanja programa otvara se sljedeći prozor:

Elementi korisničkog sučelja:
1. Osnovni  izbornik (Menu Bar)
2. Alatna traka (Toolbar)
3. Prozor komponenata (Explorer Pane)
4. Prozor tablice atributa komponenata (Attribute Table)
5. Radni prostor (Canvas)

1.1 Osnovni izbornik (Menu Bar)

Sadržaj izbornika:

5

4

3

2

1
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 FILE – omogućuje otvaranje, zatvaranje, spremanje i ispis projekta.
Također omogućuje eksportiranje datoteke u GIF datoteku te
podešavanje postavki programa.

 EDIT – omogućuje premještanje, kopiranje, stavljanje i zamjene
komponenti odnosno cijelog projekta

 PROJECT – omogućuje dodavanje podprojekta (logički podkrugovi) u
veći projekt (veći logički krugovi), otvaranje i zatvaranje datoteke s
komponentama, analizu, brisanje i preimenovanje logičkih krugova
(projekta). Također omogućuje postavljanje glavnog projekta i opcije
projekta.

 SIMULATE – omogućuje automatsku i korak po korak simulaciju
(možemo odrediti takt simulacije) i resetiranje projekta, omogućuje
zumiranje na projekt ako se radi o većem projektu te ispis svih
ikorištenih komponenata što je zgodno ako je potrebno dokumentirati
projekt

 WINDOW – omogućuje minimiziranje i maksimiziranje glavnog prozora
te otvaranje prozora Combinational analysis koji omogućuje
kombiniranu analizu projekta

 HELP – omogućava korisniku pristup svim izvornim informacijama ovog
programa.

1.1.1 Izbornik File

Slika 1.5. Izbornik File

U izborniku file možemo odabrati neke od osnovnih naredbi ovog programa.

Možemo birati želimo li napraviti novi dokument (New) ili želimo otvoriti već postojeći

dokument (Open...). Naredbom 'Close' zatvaramo aktivni dokument, dok su nam

naredbe 'Save' i 'Save As...' vrlo poznate i služe za spremanje onoga što smo

napravili u programu. Naredbom 'Export As GIF...' možemo postojeći dokument

odnosno shemu koju smo nacrtali spremiti kao sliku u .gif formatu, što je korisno ako

nam treba samo gotova shema a ne simulacije, jer tako spremljenu gotovu shemu

onda možemo otvoriti i na računalu koje nema LogiSim. Naredba 'Print...' služi za
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ispis postojećeg dokumenta. Uz pomoć naredbe 'Preferences...' možemo podesiti

neke od osnovnih opcija programa LogiSim. Naredba 'Exit' služi za izlaz iz programa.

1.1.2 Izbornik Edit

Izbornik Edit

Izbornik Edit sadrži neke klasučne naredbe koje se najčešće koriste kod rada

sa nekim dokumentom. To su naredbe za poništavanje napravljenog koraka (Undo),

naredbe za izrezivanje (Cut), kopiranje (Copy), lijepljenje (Paste), brisanje (Delete),

te naredba za odabir svih objekata koji se nalaze u dokumentu (Select All). Ove su

naredbe vrlo korištene i njih nije potrebno posebno predstavljati.

1.1.3 Izbornik Project

Izbornik Project

U izborniku Project možemo dodati novi strujni krug (Add Circuit...) tako da

nemamo samo strujni krug pod nazivom ''main'', možemo učitati knjižnice sa

sklopovima (Load Library), također imamo analizator strujnog kruga (analyze Circuit),

te naredbe za preimenovanje (Rename), te postavljanje trenutnog strujnog kruga kao

glavnog (Set As Main Circuit).

Naredbom 'Options' namještamo neke osnovne postavke za trenutni

dokument na kojem radimo.
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1.1.4 Izbornik Simulate

Izbornik Simulate

Kako bi naša simulacija radila, na opciji 'Simulation Enabled' mora biti kvačica.

Naredbom 'Reset Simulation' resetiramo cijelu simulaciju, odnosno, sve se postavlja

u nisko naponsko stanje ili logičku nulu. Naredbom 'Tick Once' jednom pokrenemo

clock pulse. Ako odaberemo naredbu 'Ticks Enabled', kada jednom pokrenemo

simulaciju, clock pulse će sam titrati odnosno generirat će impulse samostalno.

Naredbom 'Tick Frequency' odabiremo frekvenciju clock pulsa, a te frekvencije se

kreću od 0.25 Hz pa do 16 Hz (0.25 Hz, 0,5 Hz, 1 Hz, 2 Hz, 4 Hz, 8 Hz i 16 Hz).

Naredbom 'Logging...' možemo vidjeti trenutna stanja na ulazu i izlazu u binarnom

obliku (0 i 1).

1.1.5 Izbornik Window

Izbornik Window

U izborniku Window možemo odabrati smanjenje ili uvećanje trenutnog
prozora, kombiniranu analizu cijelog strujnog kruga koji smo simulirali, te koji prozor
želimo otvoriti (sada je ponuđen samo prozor 'Untitled').
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1.1.6 Izbornik Help

 Izbornik Help

U izborniku Help, kako i sama riječ kaže, tražimo pomoć. Tako možemo

odabrati 'Tutorial' gdje imamo pokazano kako se postupno grade sheme koje želimo

simulirati, te kako namjestiti neke osnovne postavke. Tako imamo za odabir više

tutorijala, neki od njih su: Tutorijali za početnike (Beginner's Tutorial), Knjižnice i

atributi (Libraries and Attributes), Podsklopovi (Subcircuits), Memorije (Memory

Components) i još puno njih. Ovdje su nabrojani samo glavni dijelovi, no svaki od njih

se grana na još nekoliko podnaslova. User's Guide je zapravo potpuno ist kao i

izbornik 'Tutorial' pa ga ne treba posebno objašnjavati. Izbornik 'Library Reference'

koristimo kada želimo sve detaljno saznati o knjižnicama (knjižnice elektroničkih

sklopova koje koristimo u simulacijama). Izbornik 'About' koristimo kada želimo

saznati one najjednostavnije informacije o programu, kao što su verzija programa, te

proizvođač, odnosno informacija o tome tko je isprogramirao taj program.

1.2 Alatna traka (Toolbar)

Sadržaj alatne trake:

 Poke Tool – služi za manipulaciju trenutnih vrijednosti povezani s
komponentama.

 Select Tool – omogućava označavanje komponenti.

 Wiring Tool – alat za postavljanje vodiča koji međusobno povezuju
komponente u projektu.

 Text Tool – tekst alat omogućuje stvaranje i uređivanje tekstualnih
oznaka i opisa  vezanih za komponente odnosno projekt.
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Pin – ulazni i izlazni pin, služe za prikaz ulaza i izlaza logičkog sklopa.

 NOT, AND, OR GATES – logički sklopovi NE, I, ILI služe kao
osnovne komponente projekta.

VAŽNO! Sadržaj alatne trake se može prilagoditi prema potrebi korisnika.
Pojašnjeno u nastavku

1.3 Prozor komponenata (Explorer Pane)
U ovome prozoru pronalazimo sve biblioteke (datoteke) komponenata koje su

potrebne korisniku kod izrade projekta. U početku imamo samo dvije datoteke:
osnovnu (Base library) i datoteku logičkih sklopova (Gates library).

Ako želimo dodati više datoteka to činimo na sljedeći način. U izborniku
kliknemo na Project  Load Library  Built-in Library

Otvara nam se prozor Load Built-in Library u kojem odabiremo željene
datoteke.
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Ako smo odabrali sve datoteke naš prozor komponenti (Explorer Pane) bi
trebao izgledati ovako:

Sada naš prozor osim one dvije datoteke (Base i Gates) sadrži datoteku
memorijski sklopova (Memory), datoteku kontrolnih komponenta (Plexers), datoteku
aritmetičkih logički sklopova (Arithmetic), datoteku ulaza i izlaza (Input/Output) i
datoteku kompatibilni komponenata (Legacy).

Ako želimo zatvoriti neke datoteke koje nam nisu potrebne u radu projekta to
činimo tako da u izborniku kliknemo na Project  Unload Libraries.
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Otvara nam se prozor Select Libraries To Unload u kojem odabiremo one
datoteke koje želimo zatvoriti.

1.3.1 Osnovna datoteka (Base)
Ova datoteka sadrži sve opće namjenske alate i komponente čije se

ponašanje u sklopu razlikuje od drugih komponenti.

1.3.2 Datoteka log. sklopova (Gates)
Ova datoteka sadrži sve jednostavne komponente od kojih svi imaju jedan

izlaz a razlikuju se po broju trenutnih ulaza.
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1.3.3 Datoteka memorijskih sklopova (Memory)
Ova datoteka sadrži sve komponente koje pamte podatke.

1.3.4 Datoteka kontrolnih komponenata (Plexers)
Ova datoteka sadrži sve kontrolne komponente. Kao komponente datoteke

log. sklopova (Gates) i ove komponente su kombinirane, ali njihov cilj je uglavnom za
usmjeravanje vrijednosti.

1.3.5 Datoteka aritmetičkih logičkih sklopova (Arithmetic)
Ova datoteka sadrži sve kombinirane komponente koje obavljaju aritmetičke

operacije na nepotpisane i dvo-komplementne vrijednosti.

1.3.6 Datoteka ulaza i izlaza (Input/Output)
Ova datoteka sadrži komponente koje odgovaraju svim tipičnim

komponentama u elektronici namijenjene za sučelje ulaza i izlaza sklopa radi lakšeg
shvaćanja rada sklopa korisnika.

1.3.7 Datoteka kompatibilnih komponenata (Legacy)
Ova datoteka sadrži komponente koje postoje samo zbog kompatibilnosti

prijašnjih verzija Logisima 1.0x serija.
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1.4 Prozor tablice atributa komponenata (Attribute Table)
U ovome prozoru definiramo atribute komponenta (broj ulaza, izlaza,

podatkovne i selekcijske bitove, itd.) ovisno o kojoj se komponenti radi.
Primjeri prozora ATTRIBUTE TABLE:



Milan Korać: Logisim

Tehnička škola Ruđera Boškovića 16

1.5 Radni prostor (Canvas)
U ovome prozoru korisnik projektira i dizajnira projekte odnosno neki logičkih

sklop koristeći sve alate koje mu omogućuje program Logisim.
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2 KORISNIČKA PRILAGODBA

Logisim podržava dvije glavne kategorije konfiguracije opcija:

 Logisim Preferences

 Project Options

2.1 Logisim Preferences
Ove postavke sadrže:

 The Template Tab

 The International Tab

 The Experimental Tab
Pokrećemo ih tako da u glavnom izborniku odaberemo File → Preferences:

Otvara nam se prozor Logisim Preferences:
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2.1.1 The Template Tab

Template (predložak) je Logisim datoteka koja se koristi kao polazna točka
svaki put kad Logisim stvara novi projekt. Opcija Plain Template odabire predložak
koji je već automatski zadan kod pokretanja Logisima. Ako želimo “bare - bones“
konfiguraciju koristimo opciju Empty Template. Opciju Custom Template koristimo
ako želimo koristiti svoj izrađeni predložak. Kod ove opcije prvo moramo odabrati
opciju Select pronaći naš predložak te onda odabrati opciju Custom Template.

2.1.2 The International Tab
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Ove postavke omogućavaju korištenje Logisima u međunarodnim zemljama.
Opcija Gate Shape služi za odabir različitih standarda crtanja log. sklopova.
Razlikujemo tri vrtse standarda: Shaped Gates (oblikovani log. sklopovi),
Rectangular Gates (pravokutno oblikovai log. sklopovi) i DIN 40700 standard. Razliku
ovih standarda prikazuje sljedeća tablica:

Opcija Language služi za odabir jezika radi lakšeg korištenja Logisima u
ostalim međunarodnim zemljama.

2.1.3 The Experimental Tab

Ove postavke omogućavaju značajke koje spadaju pod eksperimentalne,
umetnute u hambar povratni informacija korisnika. Podešavanje grafike i mogućnost
zadržavanja spojnih vodova kod pomaka komponenti.

2.2 Project Options
Ova opcija projekta sadrži:
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 The Canvas Tab

 The Simulation Tab

 The Toolbar Tab

 The Mouse tab

Pokrećemo je tako da u glavnom izborniku kliknemo na Project → Options:

Otvara nam se prozor Logisim: Untitled Options
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2.2.1 The Canvas Tab

Ova opcija nam omogućuje konfiguriranje crtanja i prikazivanja log. sklopova
odnosno projekta.Sadrži osam opcija: Printer View, Snow Gird, Show Attribute Halo,
Snow Ghosts, Snow Component Tips, Zoom Factor, First Radix When Wire Poked i
Second Radix Whem Wire Poked opciju.

2.2.2 The Simulation Tab

Ova opcija omogućuje konfiguiraciju algoritma koji se koristi za simulaciju
sklopova. Ovi parametri se odnose na sve sklopove koji su simulirani u istom
prozoru, čak i za sklopove koji postoje u drugim datotekama (bibliotekama) učitanih u
okviru projekta.
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2.2.3 The Toolbar Tab

Ova opcija omogućuje konfiguraciju alata koji se pojavljuju u alatnoj tarci. Na
lijevoj starni prikazuje sve dostupne alate, a na desnoj prikazuje trenutni sadržaj na
alatnoj traci.

2.2.4 The Mouse Tab
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Po zadanom kada pritisnemo mišem u Logisim području crtanja, trenutno
odabrani alat će se koristiti. Ova opcija nam omogućava kongiguiranje preslikavanja.
Tako možemo svaku kombinaciju miša ili tipki preslikati na drugi alat (po želji
korisnika) što nam pomaže pri bržem radu pri crtanju sklopova. Na ovaj način
dobivamo bolje rukovanje i lakši način rada sa programom Logisim.

2.3 Opcija Logging
Ova opcija nam pomaže kod testiranja odnosno dokumetiranja većih sklopova.

Omogućuje nam popis svih komponenata koje smo koristili kod izrade određenih
sklopova. S ovom opcijom možemo zabilježiti sve komponente koje smo koristili u
izradi sklopa te ih spremiti na određeno mjesto što nam omogućuje lakše
dokumentiranje i lakše shvaćanje rada sklopa.

Ovu opciju pokrećemo tako da u glavnom izborniku kliknemo na Simulate 
Logging:

Otvara nam se prozor Logisim: Log main of Untitled (u ovom slučaju Log
main of Potpuno zbrajalo):
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Popis materijala komponenti potpunog zbrajala
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3 CRTANJE LOGIČKOG SKLOPA

3.1 Postupak crtanja logičkog sklopa
Primjer: Nacrtati asinkrono binarno brojilo u programu Logisim.
RJEŠENJE:
Program Logisim pokrećemo dvostrukim klikom na ikonicu:

Otvara nam se prozor Logisim: main of Untitled

Odabiremo datoteke komponenata (libraries) koje su nam potrebne u
projektiranju ovog logičkog sklopa. To činimo tako da u glavnom izborniku kliknemo
na Project  Load Library  Bulit-in Library   odaberemo željene datoteke( u
ovom slučaju to su Memory i Input/Output datoteke)
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U ovome koraku u prozoru komponenti u datoteci Memory odabiremo T –
bistabil tako da mišem kliknemo na njega, prenesemo miš na radnu površinu i opet
kliknemo. Ovaj postupak potrebno je ponoviti četiri puta jer su nam potrebna četiri T-
bistabila.

Ako smo sve učinili kako treba naš radni prostor bih trebao izgledati ovako:

Kada smo postavili bistabile potrebno je postaviti pinove (CLOCK, BUTTON,
CONSTANT “1“, te LED diode koje će služiti kao izlazi). To radimo tako da u prozoru
komponenata odaberemo datoteku Input/Output gdje odabiremo BUTTON (označit
ćemo ga crvenom bojom jer će služiti kao RESET) i LED diode istim postupkom kao
kod bistabila. Pin CONSTANT “1“ odabiremo u datoteci GATES, a CLOCK
odabiremo u datoteci BASE također istim postupkom kao kod bistabila.

BUTTON – slika pokazuje i koje atribute moramo podesiti u prozoru Attribute
Table
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Za odabir crvene boje kliknemo u prozoru Attribute Table na Color otvara nam
se prozor Select Value gdje odaberemo crvenu i potvrdimo sve upite.

Kada smo podesili sve atribute kliknemo na radnu površinu kako bi stavili pin
BUTTON
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.
LED – slika pokazuje i koje atribute moramo podesiti u prozoru Attribute Table

Ovaj postupak ponovimo četiri puta jer su nam potrebne četiri Led diode pošto
imamo četiri izlaza. Jedina razlika je što u prozoru Attribute Table mijenjamo Label
(Q0, Q1,Q2, Q3). Kada smo podesili atribute kliknemo na radnu površinu kako bi
stavili pin LED (ponoviti četiri puta).

CONSTANT “1“ – slika pokazuje koje atribute treba podesiti u prozoru
Attribute Table

Kada smo podesili sve atribute kliknemo na radnu površinu kako kako bi stavili
pin CONSTANT “1“.

CLOCK – slika pokazuje koje atribute treba podesiti u prozoru Attribute Table
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Kada smo podesili sve atribute kliknemo na radnu površinu kakobi postavili pin
CLOCK.

Ako smo sve učinili kako treba naša radna površina bi trebala izgledati ovako:

Nakon što smo postavili sve potrebne komponente sljedeći korak jest spajanje

komponenti što činimo tako da na altnoj traci kliknemo na ikonicu  te međusobno
spojimo komponente. Kada smo međusobno pospajali komponente možemo još

dodati naziv ovog log. sklopa tako da kliknemo na ikonicu  i na radnu površinu te
upišemo naziv Asinkrono binarno brojilo. Slika pokazuje koje atribute treba podesiti
kod upisa teksta:

Ako smo sve učinili kako treba naš radni prostor bi trebao izgledati ovako:

Kada smo završili projektiranje log. sklopa možemo ga ići simulirati. To činimo
tako da u glavnom izborniku kliknemo na Simulate  Ticks Enabled
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Početak brojanja asinkronog binarnog brojila:

Simuliranje log. sklopa se odvija automatski iz čega vidimo da sklop broji 2N

gdje je N broj bistabila što je točno.

NAPOMENA: Ovakav postupak vrijedi za projektiranje bilo kojeg logičkog
sklopa.

3.2 Wires (žice)
Sada ćemo ovjasniti značenje pojedinih boja u kojima se mogu nalaziti žice.

Žice mogu biti u sivoj (gray), plavoj (blue), tamno – zelenoj (dark green), svijetlo –

zelenoj (bright green), crnoj (black), crvenoj (red) i narančastoj (orange) boji. Sada

ćemo objasniti što koja boja znači.

3.2.1 Siva boja
Kada su žice u sivoj boji, one nam signaliziraju da je njihova propusnost

odnosno širina bitova koje propuštaju, nepoznata. To znači da ta žica nije priključena

ni na jedan sklop, odnosno da je postavljena u 'zraku'.
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 Žica u sivoj boji

3.2.2 Plava boja
Žice plave boje su najčešće žice koje su spojene i nose veličinu od jednog

bita, ali vrijednost tog bita nije poznata. Na slijedećoj slici je prikazana žica spojena

na sklop I, i ona je plave boje jer ulazi sklopa I još nisu poznati, pa tako nije poznat ni

izlaz.

Žica u plavoj boji

3.2.3 Tamno – zelena boja
Tamno – zelena boja nam signalizira da žica prenosi jednobitni podatak i da je

vrijednost tog podatka logička nula („0“).

Slika 1.24. Žica tamno – zelene boje

3.2.4 Svjetlo – zelena boja
Svijetlo – zelena boja nam signalizira da žica prenosi jednobitni podatak i da je

prijednost tog podatka logička jedinica („1“).

 Žica svjetlo – zelene boje

3.2.5 Crna boja
Kada je žica crne boje, to znači da ona nosi više različitih bitova i vrijednost tih

bitova koje prenosi nije poznata. To se najčešće javlja kod dvobitnih i višebitnih

podataka koje se uz pomoć žice prenose do ostalih elemenata na shemi. Kao na

primjer, kada imamo ulaz koji je trobitan ili četverobitan. Na slici ćemo imati primjer

sa četverobitnim ulazom te različitim vrijednostima pojedinih bitova.

Žica crne boje
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3.2.6 Crvena boja
Kada je žica u crvenoj boji, to znači da je negdje došlo do greške. To se

najčešće događa ako ista žica prenosi različite podatke, kao na primjer, ako kroz istu

žicu pustimo logički nulu i logičku jedninicu istovremeno. To možemo pokazati tako

da dva izvora (pina) spojimo direktno, te jedan postavimo u stanje '0' a drugi u stanje

'1'.

Prikaz pojavljivanja crvene žice

Iz ovog primjera sa slike vidimo da do javljanja greške ne dolazi sve dok kroz

žicu ide više bitova, ali istog naponskog nivoa, odnosno logičkog stanja. Tek kada su

bitovi u različitim logičkim stanjima, dolazi do javljanja greške.

3.2.7 Narančasta boja
Žice narančaste boje nam se najčešće pojavljuju kada su dva logička sklopa

međusobno spojena, ali se ne podudaraju u širini bitova, odnosno jedan sklop na

izlazu daje trobitni podatak, dok drugi sklop na ulazu može primati samo jedan bit

podatka. Takve žice se smatraju prekinutima, jer uopće ne prenose nikakve podatke.
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 Pojava žice u narančastoj boji

Također možemo primijetiti da na krajevima žice imamo napisanu širinu

podataka u bitovima, tako je kod brvog sklopa (sklop I) širina samo 1 bit, dok je na

ulazu i sklop ILI širina postavljena na 3 bita. Također nam se na dnu prozora ispisuje

poruka: 'Incompatible Widths'.

3.3 Korištenje pomoći
Prije svakog projektiranja bilo kojeg sklopa poželjno bi bilo pročitati HELP koji

nam omogućuje lakši rad sa ovim programom. HELP odabiremo iz glavnog izbornika
tako da kliknemo na HELP  Tutorial.
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4 MINIMIZIRANJE
Program Logisim osim projektiranja omogućuje i minimiziranje logičkih

operacija što je jako korisno kod pojednostavljenja većih logičkih sklopova:
Primjer:
Nacrtati logički sklop zadan logičkom operacijom f (A,B) = A' + B' + AB' + A'B,

minimizirati ga i nacrtati pojednostavljeni oblik u programu Logisim.
RJEŠENJE:
U glavnom izborniku odaberemo Project → Analyze Circuit:

Otvara nam se prozor Combinational Analysis   odaberemo Inputs:

Upisujemo ulazne varijable A i B tako da prvo upišemo varijablu A pa kliknemo
na ADD, a zatim varijablu B
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Kada smo definirali ulazne varijable kliknemo na Outputs kako bi definirali
izlaznu varijablu Y na isti način kao ulazne varijable A i B.

Sljedeći prozor je Table koji treba izgledati ovako:
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U prozoru Expression upisujemo logičku operaciju f (A,B) = A' + B' + AB' + A'B
ali upisujemo je na sljedeći način ~A + ~B + A~B + ~A B i pritisnemo ENTER.

Nakon što smo kliknuli na ENTER na mjestu (empty) dobivamo logičku
operaciju zapisanu u ljepšem obliku.
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Nakon što smo napisali logičku operaciju moramo je nacrtati. To činimo tako
da kliknemo na tipku Build Circuit nazovemo ga Primjer i potvrdimo upite sa OK.
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Sada bi na našem radnom prostoru trebali dobiti logičku sklop zadan logičkom
operacijom           f (A,B) = A' + B' + AB' + A'B te bi ona trebala izgledati ovako:

Sljedeći korak jest minimizacija ovog izraza, a to činimo tako da u prozoru
Combinational Analysis odaberemo prozor Minimized u kojem vidimo
pojednostavljeni oblik ove logičke operacije te kliknemo na Set As Expression.
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Nakon što smo kliknuli na Set As Expression kliknemo na Build Circuit i
potvrdimo sve upite sa OK i YES:

Nakon što smo potvrdili sve upite na našoj radnoj površini dobivamo
minimizirani logički sklop (Y = A' + B') koji izgleda ovako:
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Nakon što smo nacrtali pojednostavljeni oblik i dobili drugi jednostavniji logički
sklop možemo vidjeti njegovu tablicu stanja tj. vidjeti kako on radi. To činimo tako da
u prozoru Combinational Analysis kliknemo na Table gdje će nam se prikazati tablica
stanja ovog sklopa:

NAPOMENA: Ovaj postupak minimiziranja vrijedi za bilo koju logičku
operaciju, te ako nam treba samo pojednostavljeni izraz nije potrebno crtati logičke
sklopove ( ne koristimo tipku Build Circuit).
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5 PLEXERS

5.1 Multipleksor
Multipleksor je sklop koji omogućava priključivanje više ulaznih linija, ali je

samo jedna izlazna. Koja će od ulaznih linija biti proslijeđena na izlaz ovisi o
upravljačkom ulazu. Broj ulaza za podatke (N) ovisi o broju ulaza za odabiranje M:
N=2M.

Sa lijeve strane su ulazi za podatke, sa desne strane je izlaz, a sa donje
strane je upravljački ulaz.

5.2 Demultipleksor
Demultipleksor obavlja funkciju suprotnu od multipleksora. Demultipleskor sa

jednog ulaza prenosi podataka na jedan od više izlaza. Na koji će izlaz biti proveden
podatak, ovisi o upravljačkom ulazu.

Sa lijeve strane je ulaz, sa desne su izlazi, sa donje strane je upravlječki ulaz.
Za razliku od multipleksora, demultipleksor u logisim u karakteristikama ima

opciju „Three-state?“, koja omogućuje izbor kako da se ponašaju neoznačeni izlazi.
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5.3 Decoder
Dekoder je sklop koji omogućuje protok podataka sa jednog ulaza na jedan od

više izlaza, a koji je izlaz aktivan zavisi od podatka na ulazu.

Sa donje strane je ulaz, a sa desne strane je izlaz. Izlazi su numerirani
brojevima  počevši sa 0 od vrha. Pojedini izlaz će biti „1“ ako se njegov broj poklapa
sa vrijednosti na ulazu. Ostali će izlazi biti postavljeni u stanje „0“ ili neko drugo,
zavisno o Three-state.

5.4 Bit selector
Bit selektor je sklop koji omogućuje da više bitni podatak podijelimo u grupe i

odaberemo koja će se grupa prikazati na izlazu.
Npr: Za podatak 100110 koji je 6 bitni, želimo podijeliti u grupe po 2 bita. Tada

će to izgledati ovako: 0: 10, 1:01, 2:10. Ako odaberemo da želimo 2. grupu  na izlazu
ćemo dobiti podatak: 01.

Sa lijeve je izlaz, sa desne strane je ulaz, a dolje je upravljački ulaz.
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6 ARITHMETIC (ARTIMETIČKA SEKCIJA)

6.1 Adder (zbrajalo)
Zbrajalo je sklop koje omogućuje zbarajanje dva bita. Sklop je izveden tako da

se može povezati sa drugim aritmetičkim sklopovima, tj. postoji ulaz za podatak iz
prethodnog stupnja i izlaz na idući stupanj ukoliko je potrebno. Naravno, postoji izlaz
za rješenje trenutnog stupnja.

Kod zbrajala ulazi su sa lijeve strane, izlaz je sa desne strane. Gornji pin je
ulaz za podatak iz prethodnog stanja, a dolje je izlaz za podatak koji se prenosi na
idući stupanja.

Moguće je izabrati samo veličinu ulaznog podatka.

6.2  Subtractor (oduzimalo)
Oduzimalo se sastoji od dva ulaza za podatke u trenutnom stupnju rada, jedan

ulaz za podatak iz prethodnog stupnja, jedan izlaz kao rješenje trenutnog stupnja i
jedan izlaz za prenošenje u idući stupanj. Oduzimalo radi tako da od gornjeg
podataka (gornji ulaz), oduzima donji podatak (donji ulaz).

Sa lijeve strane su ulazi, a sa desne strane je izlaz. Gore je ulaz za podatak iz
prethodnog stupnja, a dolje je izlaz za podatak u idući stupanj.
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6.3 Multiplier (množilo)
Množilo je sklop za množenje dva podatka dovedena na ulaz i prikaz rješenje

na izlazu. Kao i prethodna dva sklopa, sadrži ulaz i izlaz za povezivanje da drugim
stupnjevima.

Sa lijeve strane su ulazi, a sa desne je izlaz. Gore je ulaz za podatak iz
prethodnog stupnja, a dolje izlaz za idući stupanj.

6.4 Divider (djelilo)
Djelilo je sklop koje omogućuje djeljenje dva podatka. Kao i svi prethodni

sklopovi, sadrži ulaz i izlaz za povezivanje sa drugim stupnjevima. Ukoliko je jedan
od podatak na ulazu 0, djeljenja niti nema.

Sa lijeve strane su ulazi, s desne je izlaz. Gore je ulaz za podatak iz
prethodnog stupnja, a dolje je izlaz za podatak u idući stupanj.

6.5 Negator
Negator je sklop koji negira podatak, tj. daje suprotnu vrijednost. Negacija se

provodi tako da se od ulaznog podatak načini dvojni komplement. Logisim ostavlja bit
niže vrijednosti ne promijenjenim, i mjenja sve iznad toga.

Sa lijeve strane je ulaz za podatak, a sa desne strane je izlaz, tj. dvojni
komplement ulaza.
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6.6 Comparator (komparator)
Komparator je sklop koji služi za uspoređivanje vrijednosti dvaju podataka.

Sukladno rješenju je aktiviran jedan od tri izlaza. Vrijednosti izlaza mogu biti:
> ako je prvi podatak veći od drugog;
< ako je prvi podatak manji od drugog;
= ako su oba podatak jednaka

Sa lijeve strane su ulazi za podatke, a sa desne strane u izlazi. Ulazni podaci
mogu odabrani kao drugi komplement ili ne odabrani.
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7 INPUT / OUTPUT

7.1 Button (gumb, tipka)
Tipka je jedan od najjednostavnijih elemenata u Logisimu. Ukoliko tipka nije

pritisnuta daje stanje „0“, a ukoliko je pritisnuta daje stanje „1“.

Tipka ima samo jedan pin za spajanje. U njezinim karakeristikama može se
podesiti boja tipke, ime, položaj i oblik imena i boja imena.

7.2 Led
Led je kao i tipka jedan od najjednostavnijih elemenata. Ako je Led tamne boje

označava stanje „0“, a ukoliko zasvijetli označava stanje „1“.

Led kao i tipka ima samo jedan pin, a karakteristike su iste: mogućnost
odabira boje, uređenje oznake.
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7.3 7- segment display (sedam segmentni pokazivač)
7 segmentni pokazivač pokazuje vrijednost 8 jednobitnih ulaza. Ukoliko nema

nikakvog ulaza, boja pokazivača je tamna, a ukoliko postoji ulaz, pokazivač zasvijetli,
pokazujući određenu vrijednost.

Ukoliko pinove na pokazivaču poredamo od 1-8 i to tako da gornji čine 1-4, a
donji 5-8, tada svaki pin kontrolira:

1) središnji segment
2) gornji vertikalni segment sa lijeve strane
3) gornji horizontalni segment
4) gornji vertikalni segment sa desne strane
5) donji vertikalni segment sa lijeve strane
6) donji horizontalni segment
7) donji vertikalni segment sa desne strane
8) decimalna točka
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8 GATES (LOGIČKI SKLOPOVI)
U ovom poglavlju upoznati ćemo se s osnovnim logičkim sklopovima koji se

primjenjuju u digitalnoj elektronici. To su slijedeći sklopovi:

8.1 Konstanta
Ovaj sklop omogućuje nam da neki ulaz drugog sklopa ili neku drugu

vrijednost napravimo konstantnom. Sklop je po postavkama u logičkoj “1“, ali mi ga
možemo mjenjati u “0“. Pritiskom na taj sklop odabiremo ga i postavljamo na radnu
površinu (slika 1.-bez plavog okvira). U postavkama kao na slici 2. Ako njegovu
vrijednost promjenimo iz '0x1' u '0x0' tada njegovu konstantnost postavljamo u
logičku “0“(slika 1.-plavi okvir). Tu promjenu možemo napraviti nakon što postavimo
sklop ili kasnije odabirom kursora i pritiskom na komponentu kada dobijemo prozor
kao na slici 2. U tom izborniku osim izbora vrijednosti konstante imamo još i odabir
kolko je 'bitni' sklop kako bi ga prilagodili shemi i okrenutost(položaj) sklopa kako bi
ga spojili na koju god stranu želimo.Te postavke su osnovne i prisutne su kod svih
sklopova.

Slika 2.

Slika 1.

8.2 NOT sklop (NE)
Ovaj sklop nam omogućuje da podatak s njegova invertiramo u odnosu na

njegov izlaz tj. ako dovedemo neku kombinaciju na ulaz, na izlazu ćemo dobiti
obratnu kombinaciju. Na njegovim postavkama (slika 4.) prilagođavamo 'bitnu
operaciju' , položaj u prostoru, te veličinu sklopa (Gate Size) koja je ovdje
standardizirana samo na veličinu na slici 3. Gdje je prikazan simbol i funkcija NE
sklopa.

Slika 3.

Slika 4.
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8.3 Buffer (Privremeni spremnik)
Ovaj sklop nam omogućuje da podatak s njegova ulaza proslijedimo na njegov

izlaz, dakle djeluje nam kao običan vodič. U njegovim postavkama možemo
namještati također 'bitnu' operaciju i položaj u prostoru. Njegov simbol i funkcija
prikazani su na slici 5.

Slika 5.

8.4 AND Gate ( I sklop)
Sklop I nam daje funkciju prosljeđivanja logičke “1“ s ulaza na izlaz samo

ukoliko su na ulazu samo logičke “1“ tj. daje nam sljedeće kombinacije i riješenja kod
2-bitne oparcije: 0+0=0; 0+1=0; 1+0=0; 1+1=1. Njegova dodatne opcije kod postavki
je namještanje broja ulaza sklopa (2,3,5,7,9). Ovo je njegov simbol, funkcija, mogući
izgledi i izvedbe. Ulazi koje nismo spojili smatramo neaktivnima tj. možemo ih
smatrati da su u logičkoj “1“.

8.5 OR Gate (ILI sklop)
Sklop ILI nam služi da logičku jedinicu s ulaza prosljedimo na izlaz ako je na

bilo kojem izlazu logička “1“. Moguće je dobiti slijedeće kombinacije kod 2-bitne
operacije: 0+0=0: 0+1=1; 1+0=1; 1+1=0. Ostale postavke su iste kao kod I sklopa.
Slika  sadrži njegov simbol, funkciju, izvedbu i mogući izgled.

.
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8.6 NAND Gate (NI sklop)
NI sklop je sklop koji je mješavina I sklopa i NE sklopa. Kako NE sklop

invertira ulaz, tako sada invertira djelovanje I sklopa pa tako on radi suprotno nego
obično. Tako ćemo dobiti slijedeće kombinacije kod 2-bitne operacije: 0+0=1; 0+1=1;
1+0=1; 1+1=0. Postavke sklopa iste su kao i kod prethodnih.

8.7 NOR Gate( NILI sklop)
NILI sklop je također mješavina NE sklopa ali ovaj put sa ILI. NE sklop također

ima ulogu okretanja funkcija sklopa ILI, pa tako dobivamo slijedeće kombinacije za 2-
bitnu operaciju: 0+0=1; 0+1=0; 1+0=0; 1+1=0 Postavke sklopa iste su kao i kod
prethodnih.

8.8 XOR Gate (Isključivo ILI sklop)
Isključivo ILI sklop nam daje stanje izlaza ovisno o podudarnosti stanja ulaza,

tj. sklop radi na principu da nam na izlazu daje logičku “0“ ukoliko na ulazu imamo
više ili manje od jedne logičke “1“.  Prema tome imamo slijedeće: 0+0=0; 0+1=1;
1+0=1; 1+1=0; 1+1+0=0; 1+1+1=0; 0+1+0=1. Primjeri su na slici 10. Postavke su iste
kao kod prethodnih sklopova.
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8.9 XNOR Gate (Isključivo NILI)
Ovaj sklop je mješavina Isključivo ILI sa NE sklopom, tj. ima kao i NE sklop

ulogu da invertira, ali u ovom slučaju invertira funkciju Isključivo ILI sklopa. Prema
tome imamo slijedeće: 0+0=1; 0+1=0; 1+0=0; 1+1=1; 1+1+0=1; 1+1+1=1; 0+1+0=0.
Primjeri su na slici 10. Postavke su iste kao kod prethodnih sklopova.

8.10 Odd Parity (Neparni paritet)
Ovaj sklop djeluje tako da nam na izlazu daje logčku “1“ ukoliko je broj logičkih

“1“ na ulazu neparan tj. imamo kombinacije 1+0=1; 1+1=0; 1+1+1=1. Primjeri su na
slici 11. Postavke su iste kao kod prethodnih sklopova.

8.11 Even parity (Parni paritet)
Ovaj sklop djeluje tako da nam na izlazu daje logčku “1“ ukoliko je broj logičkih

“1“ na ulazu paran tj. imamo kombinacije 1+0=0; 1+1=1; 1+1+1=0. Primjeri su na slici
12. Postavke su iste kao kod prethodnih sklopova.
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8.12 Controlled Buffer (Kontrolirani privremeni spremnik)
Ovaj sklop ima svrhu istu kao i privremeni spremnik ali mu je u ovom slučaju

dodan jedan jedno 'bitni' ulaz koj kontrolira njegovu zadaću. Taj ulaz je tvornički
postavljen u logičku “0“ što onemogućuje sklopu da radi svoju funkciju. Ako na taj
ulaz spojimo neki signal tada mi kontroliramo rad sklopa. Ako signal postavimo u
logičku “0“ tada sklop ne radi ništa, već brani prolaz podatka, a kada je ulazni signal
u logičkoj “1“ tada je podatku dozvoljen  prolaz. Primjer je izveden na slici 13.
Postavke su iste kao i kod normalnog privremenog spremnika.

.

8.13 Controlled Inverter (Kontlorirani invertor-NE sklop)
Ovaj sklop ima istu funkciju kao i NE sklop ali mu je u ovom slučaju dodan

jedan jedno 'bitni' ulaz koji kontrolira njegovu zadaću. Taj ulaz je tvornički postavljen
u logičku “0“ što onemogućuje skopu da radi svoju funkciju. Ako mi na taj ulaz
spojimo neki signal tada mi kontroliramo rad sklopa. Ako signal postavimo u logičku
“0“ tada sklop ne radi ništa, već brani prolaz podataka, a kada je ulazni signal u
logičkoj “1“ tada je podatku dozvoljen prolaz, ali naracno pošto je to NE sklop on ga
invertira. Primjer je izveden na slici 14. Postavke su iste kao na NE sklopu.
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9 MEMORY (MEMORIJA)
U ovoj biblioteci imamo sklopove koji simboliziraju različite vrste memorija.

Zato su tu JK, SR, D i T bistabili, zatim općeniti registri i primjeri ROM i RAM
memorija.

9.1 D bistabil
To je bistabil koji nam daje određeno stanje na izlazu ovisno o ulazu i

određenom signalu vremenskog vođenja(Clock).To je inače izvedeni S-R bistabil s
zajedničkim ulazom, ali invertorom kod jednog od njih. Ako pretpostavimo da je
signal vremenskog vođenja stalne periode, tada nam sklop daje logičku “1“ na izlazu
Q kada je ista i na ulazu D. Izlaz Q' je invertiran od izlaza Q. Ako je na D “0“ tada
nam je na izlazu Q “0“. Nakon promjene stanja ulaza D potrebno je pritisnuti na clock
kako bi dobili pravi izlaz jer taj izlaz ima funkciju tek nakon sljedećeg rastućeg brida
na clocku. Daljnja 2 priključka su za Clear (CLR) i Preset (PR) signal,tj. ako je CLR
aktivan preko jedinice i ako je postavljen u “1“ tada je izlaz sklopa automatski u “1“,
isto vrijedi i za CLR ali on kada je u “1“ postavlja izlaz u “0“.Ako su oba aktivna tada
dobivamo nedefinirano stanje tj. može ispasti “0“ ili “1“. Primjer i tablica stanja su
prikazani na slici 15. Doljni sklop pokazuje rad s aktivnim CLR signalom. Ako je
aktivan jedan od dva doljnja priključka tada priložena tablica ne vrijedi. Dodatnih
postavki sklopa nema.

D Q Q'

0 0 1

1 1 0
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9.2 T bistabil
To je bistabil koji je u biti kratko spojeni J-K bistabil s jednim ulazom.

Priključenje se izvodi na isti način kao kod D bistabila. Kada je “0“ na ulazu tada
sklop zadržava prethodno stanje, a ako je “1“ tada invertira prethodno stanje. Primjer
i tablica stanja izvedeni su na slici 16.Primjena CLR i PR je ista na svim bistabilima.
Slika prikazuje dva različita slučaja kada je “0“ na ulazu tj. sklop nam zadržava
prethodno stanje. Na prvom sklopu je prethodno stanje bilo “1“, a na drugom “0“.

9.3 J-K bistabil
To je bistabil s dva ulaza tj. četiri moguće kombinacije na izlazu. Sva stanja

prikazana su tablicom stanja i primjerom na slici 17. Sve su postavke kao na ostalim
bistabilima. Stanje 0+0 daje nam izlaz isti kao što je bio i prethidno, 0+1 stanje 0, 1+0
stanje 1 i 1+1 invertirano prethodno stanje, a ako ide redoslijedom kao u tablici onda
ce stanje biti 0. Izlaz Q je ovisan o ulazu J. Na slici prvi slucaj pokazuje da nam je
prethodno stanje na bistabilu bilo 1 pa je sada 0. Izlazom Q možemo dobiti
periodičan signal.

T Q Q'

0 Q0 Q0'

1 Q0' Q0

J K Q Q'
0 0 Q0 Q0'
0 1 0 1
1 0 1 0
1 1 Q0' Q0
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9.4 S-R Flip-Flop
To je bistabil isti kao J-K ali s manom da će nam za stanje 1+1 na ulazu dati

nedefinirano stanje, dakle ili 0 ili 1. Ovdje izlaz Q ovisi i stanju ulaza S. Tablica i
primjeri su na slici 18. 1+1 kombinacija dala nam je 0, ali je mogla dati i 1.

9.5 Register (Registar)
Ovo je sklop koji nam pamti određeno stanje na ulazu i prikazuje ga na izlazu

ali nakon što mi signal Clocka pomaknemo za jednu periodu. Prikazan je kao D
bistabil jer je njegova uloga također da pamti pošto je bistabil i ne vrši nikakvu drugu
operaciju. Dakle on se ponaša kao vodič koji pamti podatak. Na slici 19. prikazana
mu je funkcija. Prvobitno stanje nam je bilo '00000111' i to smo prebacili na izlaz,
zatim smo upisali '01000111' i nije se ništa desilo. Tek nakon pomicanja periode na
Clocku podatak je prenesen na izlaz. Također nam pokazuje podatak koji smo upisali
u sebi ( '07').

9.6 RAM i ROM
To su tzv. Random Access Memory ili pristupna memorija čiji se sadržaj briše

kada ona izgubi napajanje i Read only Memory čiji sadržaj možemo samo čitati.
Ovdje je to prikazano na drugačiji način. Ako postavimo određeni ulaz to nam diktira

S R Q Q'
0 0 Q0 Q0'
0 1 0 1
1 0 1 0
1 1 1* 1*
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adresu memoriske lokacije podatka i na izlazu nam ispisuje podatak na toj
memoriskoj lokaciji. Kod ROM memorije možemo u postavkama otvoriti Contents
opciju tj. opciju sadržaja kako bi vidjeli cijelu memoriju i njen sadržaj. Ulazi Selection i
Output (samo kod RAM-a) su standardizirano postavljene u 1 i ako ih mi postavljamo
također bi trebale biti u 1 jer inače sklop ne izvršava svoju funkciju. Na slici 20.
Prikazani su u gornjem dijelu RAM a u donjem ROM memorija.Na početku svakog
reda imamo adresu prvog bajta i u svakom redu je 16 bajtova. RAM memorija ima
CLR ulaz, tj. kada je taj ulaz aktivan cijeli njen sadržaj se briše. Taj CLR predstavlja
gubitak napajanja (Slika 21.).
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10 LEGACY (NASLJEĐE)
Ova datoteka sadrži komponente koje postoje samo zbog kompatibilnosti

prijašnjih verzija Logisima 1.0x serija.
Ova biblioteka je vrlo mala i sadrži svega tri komponente i to D, J-K bistabil i

Registar. Te komponente nemaju CLR ulaze niti bistabili u sebi pokazuju stanje na
Q, već moramo sami spojiti izlaz. Registar nam je ponuđen samo 8-bitni.

10.1 Logisim 1.0 D (J-K) Flip-Flop
Funkcije su iste kao kod već opsianih ali bez gore navedenog. Primjeri su na

slici 22.

10.2 Logisim 1.0 8-Bit Register
Ovaj registar je 8-bitni te ima 8 različitih ulaza i izlaza simbolizirajući svaki

učaz kao 2 bita. U njemu je zapisana vrijenost koju smo mu upisali, ali u
heksadekadskom kodu. Vrijednosi idu od 00 do FF kombinacije. Primjer za 0F
prikazan je na slici 23. Za upisivanje 0F upisali smo 11110000.


